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Introduction 
Technical Support 

Welcome to the instructional manual for the Tasks module within the Eagle Business 
Management System (EBMS).  In the sections following, explanations and examples of the 
available features within the Tasks Module will be explained.  If you need to reach our staff for 
further help, contact us using the information below: 
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Overview 

The task module is useful in managing a variety of work orders, phone calls, contacts, and other 
tasks.   These tasks are conveniently connected to customers, sales orders, serialized whole 
goods, timecard detail, and/or jobs.  The following examples will demonstrate some of the popular 
uses for this module 

• Organizing, scheduling, and printing work orders:  The task module can be used 
to schedule work orders for almost any service business.   The task work order system 
is a power tool for electricians, vehicle repair centers, small engine repair, HVAC 
companies, computer repair, and almost any other service or repair business.    
Review the Using Tasks as Work Orders section for more details. 

The task module is a powerful tool to track the time and materials for T&M jobs or track 
the actual time spent on projects with an estimated time.   Review the Time and Material 
tasks vs. Contract Tasks section for details on using tasks to track time. 

The multiple views can be configured by the user to group and query tasks in a wide 
variety of combinations.  Review the Creating Multiple Views, Creating Queries , and 
Creating Task Groups for more details. 

• Evaluating the billable time for a service company:  Managing a service company 
or division requires affective tools to measure the efficiency of labor and employees.    
Comparing billable time to the actual time is a powerful way to evaluate the profitability 
of individual employees or an entire service department.  The task module allows the 
user to manage labor more effectively by quantifying the billable time using different 
work codes within payroll.  The management reports within EBMS allow the personnel 
manager to base employee pay on his/her efficiency and performance.  Review the 
Billable Time section for more details. 

• Sales person’s contact manager:  The task module is a useful tool for a sales 
person to track customer information, sales contacts, and other customer relation 
information.   Review the Using Tasks as a Contact Manager section for more details.  

• Logging customer support contacts:   The task module includes a number of 
features to log, organize, and evaluate phone calls, service calls, and follow up 
contacts.   Review the Using Phone Tasks section for more details.   

• Recording events contained within a specific job:  The powerful combination of the 
optional EBMS task and job costing modules are great to track labor, material, and 
billing processes within a construction, manufacturing, or other type of job or project.   
Review the Using Tasks and Job Costing for more details. 

• Tracking details for service contracts: The task module can be used to track labor 
that is related to a service agreement or annual contract.    Review the Using Tasks 
and Job Costing for details. 

• Maintaining history regarding individual pieces of equipment or whole goods:   
Logging contacts, service history, and other task detail is very valuable in managing 
labor in a service business.  Review the Reviewing Task History for more details.   
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Getting Started 
Creating Task Types and Defaults 

Planning the type of tasks that will be used within the EBMS system and creating these types will 
greatly simplify the task creation process.   Task defaults and standard settings are created within 
the task type in a similar manner as setting defaults within a customer or inventory folder.     To 
view, change, or create task types go to Tasks > Options and click on the Task Types tab as 

shown below: 

 

A separate task type should be created if the base type is different (see base type explanation 
below) or the default settings of the task (such as labor work codes, service codes, approval 
processing) are different.      

Select a task type and click the Properties button. 

 

Creating a task type consists of 2 settings: 
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1. The task Type is the ID that identifies the type of task. 

2. The Base Type is a setting that identifies the format of the new task wizard and some 
billing processes.    The available Base Types are as follows: 

a. The Phone type is used to log phone contacts such as support calls.  A task 
with a base type of Phone tracks the time immediately when the task wizard is 
launched.  The phone task is marked completed when the wizard is 
completed.    The Phone task should not be used for sales calls or phone 
tasks that are ongoing.   Review the Using Phone Tasks section for an 
example of the new task wizard with a base type of Phone. 

b. The Sales base type allows the user to utilize the task module as a contact 
manager.     Review the Using Tasks as a Contract Manager section for more 
details. 

c. The Time and Materials Service type should be used for any work order or 
project that is billed by the actual labor spent on the project rather than a fixed 
rate or contract.     Use the Contract Service base type if the job is not billed 
based on the actual time spent on the project.   This includes fixed rate jobs, 
contracts, or any other task that is not billed based on the total Actual Time 
entered in the Time tab of the task.  Review the Time and Material tasks vs. 

Contract Tasks for more details. 

d. Use the Warranty Service type for tasks that require time but are not billed 
similar to the Sales base type. 

Click OK to return to the task type list. 

The small engine repair and rental center may use a list of task types as shown below: 

 

    The following table lists the probable Base Type Setting as well as the default settings for each 

task type. 
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• The Other task type was created to be used when no other task types are applicable.   
This type will require the user to enter all the information for a task since the default 
settings of the other types do not apply.  The base type for this setting should be 
Contract Service unless the miscellaneous task involves billing.  Review the Billing a 

Project or Task section for billing details. 

• Both Rental Equipment Prep and the Rental Equipment Repair or Service types 
have a base type of Contract Service since rental equipment preparation task 
contains no time & material labor fee.  Review the Time and Material tasks vs. 
Contract Tasks section for more details. 

• The Repair Work Order type was created for general repair tasks.   This task type 
should have a base type of Time and Materials Service if repair labor is billed based 

on the amount of time that was spent by the repair technician.   

• The Sales Contact type was created for tasks created by the sales person to track 
sales contacts.   This type is configured with a base type of Sales since a sales 
contact type is not billed to the customer.  Review the Using Tasks as a Contact 
Manager  section for more details on using the Task module as a contact manager. 

• The Sharpen Blades and Standard Service and Oil Change types were created for 
common tasks that are billed using a standard fee.    A task with a set fee should have 
the base type set to Contract Service.  This allows the user to set the time and cost 
allocated to a standard task such as sharpening blades or changing oil.  Review the 
Attaching a Task to a Service Item section for more details about setting a fixed cost 
and time to a task. 

• The Support Call task was configured to be used for support calls that are tracked for 
history.   The base type was set to Phone.   Review the Using Phone Tasks for more 

details. 

• The Warranty task was created for tasks that are not billed.   The base type was set to 
Warranty.    

These types are only examples.    A company’s task types will vary drastically based on the 
way the Task module is used within the company. 

The default values should be set for each task type in a similar manner as the default 
customer settings within the customer folder list in Sales > Options.   Complete the following 
steps to set the default values:  

Select a task type and click on the Edit Defaults button to open the following window: 
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The Task window appears very similar to the task entry window but is used only to enter default 
values.  Any data you enter into any of the entry fields will default the next time you create a new 
task.    Review the Creating an Open Task section for more details on individual fields.   

Suggested Task Default Settings 

General Tab 

• Most of the Schedule entries should be kept blank.   The Duration field can be set 
if the average time spent on the selected task type is somewhat consistent.    
Enable the Appointment Confirmed and Pending options only if a new task 
should default to a confirmed or pending status. 

• Set the default Location option to either In-House or On-Site based on the 
standard location for this type of task. 

• Set the standard Priority level. Set to Normal if there is no standard Priority level.   

The remainder of the general tab fields can remain blank.   

Advanced Tab 
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Enter a customer ID in the Customer field.  If the task does not relate directly to a customer 
leave the field blank or enter a generic customer ID.   For example, if the Rental Equipment 
Prep tasks are not billed to a customer, the Customer ID could be set to a generic customer 
or company name (example: QUAHAR – Quality Hardware).   This allows the user to bypass 
the required Customer ID entry when creating a new task.      

The Manager setting should be set to the appropriate manger that approves or manages the 

task.   Review the Approving Tasks section for more details on approving tasks before billing. 

The Service setting is the inventory item used to bill the task.  This entry should be an 
inventory item classified as Service.   Keep this entry blank if the inventory item used to bill 
the task is not consistent.   Review the Billing a Project or Task section for more details on 
this entry.   

The Approved switch should be disabled unless this task type does not have an approval 

step.   Review the Approving Tasks section for more details on approving tasks. 

The remainder of the fields on the Advanced tab should be kept blank or unchanged. 

Time Tab 
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The Work Code setting should contain the default work code used by the employee when 
entering time into the task.     This setting should be populated since the work code should be 
consistently associated with the task type.   

The Job and Stage settings should only be populated if the task always relates to the same 
Job.  These entries will only appear if the job costing module is installed.    Review the Job 
Costing documentation for more details on job costing.  These entries are blank within the 

default settings under normal situations.   

The remainder of the settings on the Time and Materials tabs should remain blank. 
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Using Tasks as Work Orders 

Using a task as a work order to schedule, track, and invoice service requests or projects is a 
common  

The following flow chart depicts the typical flow of information within the EBMS work order system 
using tasks. 

Status Settings 

 

 

 

A. A service task can be created from an inventory item that is entered within a sales order or 
a proposal.    The user is prompted to create tasks when the Process > Create Sales 
Order wizard is launched from the proposal menu if service inventory codes are contained 
within the quote.      The Enter tasks for this item option within an inventory service item 
must be enabled to create tasks using the wizard.      The user will be prompted to create 
tasks within a sales order if a service inventory item containing a task type is entered 
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within the SO.    Review the Attaching a Task to a Service Item and the Creating a Task 
from a Proposal or Quote  sections for more details. 

B. A task work order can be created at the time of the service request and attached to a sales 
order at the time the service is billed.    Review the Creating an Open Task section for 
more details. 

C. The task module contains scheduling tools that allow a company to schedule individual 
technicians or crews.      Review the Scheduling Tasks sectionfor more details 

D. A task can be put "on hold" by marking a task as Pending.    This feature is used to hold a 

service work order rather than scheduling or completing the task.    

E. Technicians often use a printed work order when a computer is not convenient.   The work 
order can be used to track parts, record labor, and make notes.   The work order also 
includes a bar code that is useful if scanners are used.   A variety of work order forms can 
be generated from the task module.   Review the Printing Tasks and Work Orders section 
for printing options. 

F. A task or work order may be put on hold if the technician is waiting on parts or materials to 
complete the task.     Review the Waiting on Parts or Materials section for more details. 

G. Record the time, parts, and details about the project.   Mark the task completed when the 
project is completed.    Documenting a task is valuable for tracking parts, managing labor, 
and maintaining a historical record about the project.    Review the Recording Parts and 
Materials section and Recording Labor and Completing the Task  for more details. 

H.  The approval is an optional step used when a manager is required to review some or all 
work orders before a task is billed.     Review the Approving Tasks section for more details. 

I. Billing the project or task is done after a task is completed and approved.   Review the 
Billing a Project or Task section for more details. 

J. Task history can be reviewed at any time supplying the user with maintenance history for a 
customer, piece of equipment (serialized item), or job.    Review the Reviewing Task 
History section for more details. 
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Creating Multiple Views 

The task module includes some very flexible tools to view tasks or work orders.      These views 
allow the user to manage and schedule tasks quickly and efficiently.      The task windows can be 
configured to list tasks in a variety of views including the following: 

• List tasks by employee to manage a specific employee’s work orders 

• List tasks by status to manage the task from start to finish 

• List tasks by date to assist with scheduling 

• List tasks that are pending or are waiting for parts 

Tasks can be listed, queried, or grouped by any field within the system. 

The main task view window is launched by selecting the Task option from the Task menu as 

shown below: 

Each view can be labeled for specific purposes and each contains a user defined Query and 
Group.   Right click on the tab of an existing view to open the context menu as shown above.    
Click on the New View to create a new tab view.    Tabs can be moved by selecting the Move 
View option dialog as shown below: 
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Click on the any of the View tabs listed to move the tab to the left of the selected View.    Click on 
the first or last option to move the tab to the far left or far right position of all the tabs. 

Select the Delete View option to remove a view tab.   This option does not remove any 
information from the system.   The Delete View only removes the list configuration. 

The benefit of creating multiple views is that it allows the user to switch from one view to another 
quickly.    The software does not need to reload and group information each time a new view is 
desired.    

Each view needs to be configured to list and group information in the desired format.     There are 
3 main options to set within each view.   These 3 options can be activated by clicking on the 
specific toolbar icon as shown below: 
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The Search icon  is used to show the Search field.   The user may click on a column within 
the task list to identify the column that is being searched.    A specific task can be located by 
typing information into the Search field in a similar manner as other lookup lists. 

The Query icon  is used to limit the view to tasks that meet the query or filter condition.  
Review the following section - Creating Queries for details on creating Queries.      

Click on the Group icon  to group tasks in groups.     If the Group option is enabled, the 
system loads all the applicable tasks into memory.    It is important to disable this option if a large 
number of tasks are being listed.    

These views are maintained for each user within the Windows Registry.    The view settings must 
be set within each computer. 

The following view combinations are common settings used in a variety of companies: 

Group Label Query Setting Group Setting Comments 

Schedule Open Work 
Orders 

By Employee and 
Start Date 

This is an excellent view to use to 
schedule multiple technicians or 
employees 

My Tasks Employee & 
Status 

Start Date (or Due 
Date) 

This is a good view to use for 
individual schedules 

Waiting for 
Parts 

Pending & 
Waiting for 
Parts 

None Review the Waiting for Parts or 
Materials section for more details 

Overdue Overdue (and 
manager) 

Employee, Due 
Date, or Customer 

This view is an excellent method to 
review tasks that are past due 
quickly. 
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To Be 
Approved 

To be 
Approved 

Customer (or task 
Type) 

Review the Approving Tasks 
section for more details on creating 
this view. 

My Query My Query (varies) This query is used to allow the user 
to quickly change the query for 
specific uses. 

Status 
(Customer 
View) 

Customer 

No Query if 
used in 
customer tab 

Status This view is an excellent setting to 
use in the task tab of the customer.    
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Using Phone Tasks 

The phone task type is used for support or sales calls that are completed at the time the task is 
created.    The task time is metered at the time the task wizard is launched until the task wizard is 
completed.   This task type is to log phone calls with customers.     Complete the following steps 
to create a phone task: 

1. A phone task such as a support call log should have a Base Type of Phone.  Go to 
Task > Options > Task Types and click the New button.    

 

2. Enter a brief task Type description of the task type and set the Base Type option to 
Phone.    Click the OK button to save. 

3. Select the task type from the task type list and click on the Edit Defaults button.   Set 
all the appropriate defaults for the phone task type.    Some suggestions are listed 
below: 

a. General tab – Set the Location and Priority settings accordingly 

b. Advanced tab – Set the Manager and Service item if applicable.   Review the 
Approving Tasks section for more details about the Manager option.   Review 
the Attaching a Task to a Service Item for more details on the Service item 

settings. 

c. Time tab – Set the default Work code for phone tasks.   Enable the 
Completed option if the task should be marked completed after the phone 

call.  

Click on the OK button to save the settings and options. 

4. Launch the new task wizard from the task list.  Review the Creating an Open Task 
section for more details on launching the new task wizard.  
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5. Select the phone task Type. 

6. Click the Next button and enter the Customer information. 

 

7. Enable the Link Task To Invoice option if the phone support is invoiced.  Click Next 

to continue. 
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8. Enter a brief Description of the phone call.  Add any pertinent Notes.  The Elapsed 
Time is calculated from the time the task wizard is launched.    Click the up or down 

arrows  to increase or decrease the timer.   Click on the pause button  to pause 
the timer.    Click on the Next button when the call is completed. 

9. The Actual Time value is set to the time calculated from the new task wizard timer.   

 

10. Enter the Billable Time.    The Work code should default to the code entered in the 
task type defaults.   Review the Creating Task Types and Defaults section for more 
details on setting defaults. 
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11. Enable the View Task option to open the task after the wizard is completed.   This 

option should only be enabled if additional information is required on the task.    

Enable the Completed option within the defaults settings of the task type to mark every task 
as completed when the wizard is finished.   Review the Creating Task Types and Defaults 
section for more details about entering default values.   
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Using Tasks as a Contact Manager 

The task module within EBMS can be used to log contact details with a customer.    This module 
can be used in place of or in conjunction with software products such as MS Outlook, Act, or 
Goldmine.     

Setup a sales contact task type by completing the following steps: 

1. Go to Tasks > Options and click on the Task Types tab. 

 

2.  Click on the New button and create a sales contact type: 

 

3. Enter a Type ID to identify the sales contact type.    

4. Change the Base Type setting to Sales or Phone. The Phone type should only be 
used if most sales contacts are made via phone and the task timer should be active as 
soon as the task wizard is launched.   Review the Using Phone Tasks for more details.   
Use the Sales base type to record sales contact other than phone calls.   
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5. Select the new sales contact type and click on the Edit Defaults button. 

 

6. Set the following default settings for a sales contact task: 

a. General tab:   Set the Location and Priority settings according to the most 
common sales contact task.     The user may wish to enter a default 
description with prompts within parentheses.   Enter any default notes or 
labels for standard information. 
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b. Advanced tab: Select the sales manager in the Manager setting.   Enable the 
Approved option unless sales contact tasks require approval.     Review the 
Approving Tasks section for more details on the manager setting and approval 
option. 

c. Time tab:   Enter the sales work code setting if the work code used to record 
sales time is consistent.   Review the Recording Parts, Labor, and Completing 
Task section for more details on the work code setting. 

d. There are not default settings that should be set within the Materials tab  

A new sales contact task can be launched from the main task window or from within a customer 
record.     Review the Scheduling Tasks section for more details on using the main task window 
(Task > Tasks from EBMS menu) to schedule sales contacts.         Open a customer record to 
create or edit a sales contact task by going to the Tasks tab of the customer.    

 

The task tab within a customer can be configured to query and group the tasks according to the 
needs of the user.   These settings only affect the Windows profile of the local computer and does 
not affect other computers.    The sales person may wish to query the tasks in one of the 
following ways: 

• Select Status from the Query options.   Select Open from the Status options to only 
list the open tasks as shown above. 

• Set the Query option to Manager and select the sales manager to list only the sales 
contacts 

• Disable the Query option so all the tasks for this customer are listed.     The query 

option can be disabled by clicking on the  icon above the group setting. 

Some common Group options used within a customer record are as follows: 
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• The Status option to list all tasks based on the status of a task.   This option allows the 
user to identify open or pending tasks quickly.    Review the Using Tasks as Work 
Orders for some status options or the Task Status Settings section for details about 
status options. 

• The Type option groups tasks based on the task type.   See example listed above. 

Complete the following steps to create a new sales contact task: 

1. Click on the New button to the right of the task list within the tasks tab of a customer.   
(Select Edit > New from the EBMS menu to launch the new task wizard within the 

main task window) 

 

2. Select the sales contact Type and click Next. 
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3. The Customer ID will default if the new task wizard is launched from the task tab of 
the customer.  Otherwise the Customer must be selected.   The Link Task To 
Invoice option should be disabled.  Click Next to continue. 

 

4. The Serial Number and Service code can be ignored in a sales task.    Enter Notes 
about the sales contact and click Next. 

 

5. Set the appropriate Start Date and Due By dates.   Review the Scheduling Tasks 
section for more details on the task date settings.     Change the Priority and 
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Location setting if appropriate.    Enter the sales person’s Employee ID.      Employee 
records should be created for all sales persons including those that are not on payroll.    
None payroll sales people should be group in a separate employee folder group.   
Review the payroll documentation for more details.   

6. Enable the View Task option to record open the task after the wizard is completed.   
Click the Finish button and the task will open.    Click on the Time tab as shown 

below: 

 

7. Enter the time that was spent on the sales contact and notes on the discussion.    
Review the Recording Parts, Labor, and Completing Task section for more details on 
the Time tab. 

The time entered within the Time tab of the task will be recorded within the sales person’s 

timecard.   Review the payroll manual for more details.   
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Creating and Scheduling 
Tasks 
Creating an Open Task 

A task can be created from any task list.   Click on Edit > New if the main task window (Tasks > 
Tasks) is in focus.    Click on New button within the customer task tab (Sales > Customers > 
Task tab) as shown below: 

 

1. Select the task Type from the first page of the new task wizard and click Next.  
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2. Select the Customer.  Note that the customer defaults to the open customer if the new 

task wizard is launched from the customer’s task tab.   

3. Select a Manager.   Review the Approving Tasks section for more details on the manager.    

4. Enable the Create Multiple Tasks option to create multiple tasks for the same project.  
This feature allows the user to duplicate information between tasks.   See step Error! 
Reference source not found. for entry details on creating multiple tasks at once. 

5. Enable the Link Task To Invoice option if the task is to be linked to a new or existing 
sales order or invoice.  Disable this option for tasks that do not involve billing.  Click Next 

to continue. 
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6. The Serial Number entry will only appear if the serialized item option is installed.    Select 
the Serial Number of the equipment being serviced, if applicable.  This entry can be 
ignored if the task or work order is not attached to a serialized item.   Review the 
Serialized Item  documentation for more details on serialized items.   

7. Enter the Service inventory item.   This entry can be ignored if the task is not attached to a 
sales order or invoice.   Review the Attaching a Task to a Service Item section for more 
details on the Service inventory item. 

8. Enter a brief Description of the task.   Enter any detailed Notes about task or work order 
and click Next.  
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9. Enter the Due By date of the task or work order. 

10. The Duration is an optional entry that is used to determine the amount of time that is 
estimated to complete the task.    The Start Date and Employee entered can be kept 
blank if the schedule is determined by another person. Review the Scheduling Tasks 
section for more details on scheduling tasks. 

11. Set the Priority and Location if applicable.    

12. Enable the View Task option to open the task when the wizard is complete.  

The following wizard page will only appear if the Link Task To Invoice option was enabled on 

the second page of the wizard. 
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13. Select the first option to create a new sales order or invoice.     Select the I want to link 
this task to an existing invoice option to append the item to an existing sales order.    
The second option allows the user to attach tasks to sales orders or processed invoices by 
changing the Status query.   The recommended Status query is the Sales Order option 
since additional time can only be appended to sales orders.   Click on an existing sales 
order and click the View Invoice button to open an existing invoice or order.    

14. Enable the View the invoice after linking option to open the invoice after the wizard is 
completed. Review the Time and Material tasks vs. Contract Tasks section for more 
details on connecting a sales order to a task.  Click the Next or Finish  button to continue.   

The following wizard page will only appear if the Create Multiple Tasks option was enabled on 

the second page of the wizard 
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15. Enter additional Employees, Descriptions, Service codes, or other differences and the 
system will create a task for each line on the task list.    Click Finish to complete the 

wizard. 

The sales order or invoice linked to the task will be displayed at the end of the wizard if the View 
the invoice after linking option is enabled.   

New tasks are normally created with a status as Open.   Review the Task Status Settings section 

for details on changing the status of a task.   
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Attaching a Task to a Service Item 

An inventory item classified as a Service item is an important component when associating the 
task to a sales order or invoice.   The service item is used to prompt the user to create a task 
from an invoice or proposal.   The service is also the link that translates the billable time to the 
sales order or invoice.    Complete the following steps to attach a task to a service item: 

1. Open an existing inventory item that is classified as Service as shown below: 

 

Review the Inventory > Using the Inventory Module for Non-Inventory Items > Using 
Inventory Items to Identify Service Items section within the main manual for more details 
on creating a service inventory code. 

2. The Estimated Hours entry is used as the ratio between the billable hours and the 
sales order.     A value of ‘1’ should be entered if the billable hours is to equal the 
quantity within the sales order.  For example, if a time and materials work order or task 
is billed by the hour enter a value of 1 into the Estimated Hours entry.   Each time the 
time is changed in the task the quantity would be updated using the Estimated Hours 

value. 

• If the task is created from the sales order the Billable Hours within the time tab = 
Quantity in SO * Estimated Hours within the inventory item.   Review the Creating 

a Task from an Invoice section for more details. 

• If the sales order is created from the task the sales order quantity = Billable Hours 
divided by the Estimated Hours value within the task.   Review the Time and 
Material tasks vs. Contract Tasks section for more details on creating sales orders 
from tasks. 
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3. Enable the Enter task for this item option to prompt the user to create a task when 
this item is entered into an invoice or proposal.     The prompt to create tasks will be 
when the invoice is saved or a sales order is created from the proposal screen.    

4. Select the Default Task Type.   The new task wizard will default to the selected 
Default Task Type.   

The service items that have a task type attached will prompt the user to create tasks when a 
sales order is created from a proposal or when the service item is inserted into a sales order.   
Review the Creating a Task from a Proposal or Quote or Creating a Task from an Invoice for 
more details. 

Review the Inventory > Using the Inventory Module for Non-Inventory Items > Using Inventory 
Items to Identify Service Items section of the main EBMS manual, for more details on items 
classified as service items.  
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Creating a Task from an Invoice 

Create Tasks  Using a Service Inventory Item 

An inventory item classified as a Service item can be flagged to create a task when it is entered 
into a sales order or invoice.     The Enter task for this item option must be enabled within the 
General tab of the inventory item.    Review the previous Attaching a Task to a Service Item 

section for details. 

Enter the service item into a sales order as shown in the graphics below.    The system will 
prompt the user to create tasks when the invoice is saved.    Click File > Save to activate the 
create task dialog.   The dialog will not appear if the task is not attached to the service item or if 
the service item was entered previously and the dialog was canceled.    Review the following 
section to add, remove, or edit tasks associated with the sales order.  

Create Tasks from the Invoice Task List 

Tasks can be created directly from the sales order menu.    Open a sales order and select View > 
Tasks from the sales order menu as shown below: 

 

The task list dialog lists all tasks that are attached to the sales order.    Additional tasks can be 
attached or created from this window. 
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Click the View Task button to view an existing task. 

Click the New button to create a new task and attach it to the existing sales order.   Review the 

Creating an Open Task section for more details on the new task wizard. 

Click on the Add Existing button to associate an existing task to the sales order. 

Highlight a task and click the Disassociate button to remove the task from the sales order 
without deleting the task. 

Click on the Delete button to delete the task. 

Click OK to return to the sales order.    
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Creating a Task from a Proposal or Quote 

Service inventory items within a proposal can prompt the user to create tasks when a sales order 
is created from a proposal or quote.   The service items must have a task type attached to the 
item.   Review the Attaching a Task to a Service Item section for details on creating a service 
item. 

The example below contains a service inventory item (SHABLA) that is connected to a task type. 

 

Launch the Create Sales Order wizard from the Process menu of the proposal.  Review the 
Proposals > Processing Proposals >Creating a Sales Order  section of the proposal 
documentation for more details on the Create Sales Order process.  The following dialog will 
appear after the sales order is created: 

  

Click on the Yes option to open the following Create Tasks dialog: 



Tasks 

36 

  

The dialog will list the inventory items contained within the proposal that are classified as Service 
and have the Enter task for this item option enabled within the general tab of the inventory item.     

The tasks are created by clicking on each Service Items and clicking on the Create Task button.   
The new task wizard must be run individually for each service item.      Service items can be 
combined by creating a task for one of the items, changing the billable time manually to total the 
amount of the combination of the items, and then ignoring the other items.   

The New Task button can be used to launch the new task wizard without copying information 

from a service item.    

Review the Proposal documentation for more details on creating and processing proposals.   
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Scheduling Tasks 

The task module of EBMS can be used to schedule tasks or work orders for employees or 
departments.    The date and time settings within the task are used to track the schedule date, 
due date, and track the progress of the task.    Complete the following steps to configure the main 
task window to assist with scheduling tasks: 

1. Open the main task window by selecting Task > Tasks from the main EBMS menu. 

 

2. Rename the main task list tab located in the upper left corner of the task list.    The tab 
may be labeled as Task List 1 as shown above.     Right click on the list label and 
rename the tab as Employee Schedule or other applicable label.      

3. Set the Query setting to Status as shown above and select the Open Status option as 
shown above.  This will cause only the open tasks or work orders to be listed.  An 
additional query may be needed to only show open tasks for a specific manager if only 
a specific group of open tasks are being scheduled.   Review the Creating Queries 
section for more details on query options.  

4. Set the Group option to Employee & Start Date to group open tasks by employee and 
scheduled start date.     All open tasks that are not assigned will be grouped in the 
(none) folder.     Review the Creating Task Groups section for more details about 

groups. 

5. Create a second view to list tasks by due date.    Right click on the list tab as shown 
below and select New View from the context menu.     
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6. Label the second tab Due and click OK to create the second tab. 

 

7. The second tab will open with the same Query and Group settings as the original tab.   
Review the Creating Multiple Views section for more details on creating multiple tab 
lists.  Change the Group option to Due Date as shown below: 

 

8. The tasks are grouped by the due date within the task.   The task groups can be 
expanded to list tasks within each past due date.     Click on the All Tasks folder to list 
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all open tasks.  Click on the Past group to view only the tasks that are past due.  Click 

on the individual dates to view only the tasks within a specific date.   

Folder groups will appear only if a task exists within that group or date.    Note the No 
Due Date folder in the list above.  This grouping is useful to identify tasks with no due 

date.   

Create additional tab views if additional lists such as pending tasks, tasks that are on hold waiting 
for parts, or completed task are needed.   

Open a task by double-clicking on the task.  The Schedule entries are found within the General 

tab of the task as shown below: 

  

 

The Schedule entry fields are used primarily to schedule the task.   The Due By date should be 
used if there is a deadline to complete the task.   The Start Date and Time is to be used to 
schedule the task or work order.    The Duration field is an optional entry used to estimate the 
amount of time required to complete the task.    Populating the Duration entry will populate the 
End Date and Time.     

Enable the Appointment Confirmed option if applicable.   This enabled option will cause the 
task to show using a green color on the schedule list.    

 

Tasks can be temporarily moved to a pending or waiting for parts list by changing the status.   
Review the Task Status Settings for more details on the status of the task.  
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Customizing Task Views 
Creating Multiple Views 

The task module includes some very flexible tools to view tasks or work orders.      These views 
allow the user to manage and schedule tasks quickly and efficiently.      The task windows can be 
configured to list tasks in a variety of views including the following: 

• List tasks by employee to manage a specific employee’s work orders 

• List tasks by status to manage the task from start to finish 

• List tasks by date to assist with scheduling 

• List tasks that are pending or are waiting for parts 

Tasks can be listed, queried, or grouped by any field within the system. 

The main task view window is launched by selecting the Task option from the Task menu as 
shown below: 

Each view can be labeled for specific purposes and each contains a user defined Query and 
Group.   Right click on the tab of an existing view to open the context menu as shown above.    
Click on the New View to create a new tab view.    Tabs can be moved by selecting the Move 
View option dialog as shown below: 
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Click on the any of the View tabs listed to move the tab to the left of the selected View.    Click on 
the first or last option to move the tab to the far left or far right position of all the tabs. 

Select the Delete View option to remove a view tab.   This option does not remove any 
information from the system.   The Delete View only removes the list configuration. 

The benefit of creating multiple views is that it allows the user to switch from one view to another 
quickly.    The software does not need to reload and group information each time a new view is 
desired.    

Each view needs to be configured to list and group information in the desired format.     There are 
3 main options to set within each view.   These 3 options can be activated by clicking on the 
specific toolbar icon as shown below: 
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The Search icon  is used to show the Search field.   The user may click on a column within 
the task list to identify the column that is being searched.    A specific task can be located by 
typing information into the Search field in a similar manner as other lookup lists. 

The Query icon  is used to limit the view to tasks that meet the query or filter condition.  
Review the following section - Creating Queries for details on creating Queries.      

Click on the Group icon  to group tasks in groups.     If the Group option is enabled, the 
system loads all the applicable tasks into memory.    It is important to disable this option if a large 
number of tasks are being listed.    

These views are maintained for each user within the Windows Registry.    The view settings must 
be set within each computer. 

The following view combinations are common settings used in a variety of companies: 

Group Label Query Setting Group Setting Comments 

Schedule Open Work 
Orders 

By Employee and 
Start Date 

This is an excellent view to use to 
schedule multiple technicians or 
employees 

My Tasks Employee & 
Status 

Start Date (or Due 
Date) 

This is a good view to use for 
individual schedules 

Waiting for 
Parts 

Pending & 
Waiting for 
Parts 

None Review the Waiting for Parts or 
Materials section for more details 

Overdue Overdue (and 
manager) 

Employee, Due 
Date, or Customer 

This view is an excellent method to 
review tasks that are past due 
quickly. 
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To Be 
Approved 

To be 
Approved 

Customer (or task 
Type) 

Review the Approving Tasks 
section for more details on creating 
this view. 

My Query My Query (varies) This query is used to allow the user 
to quickly change the query for 
specific uses. 

Status 
(Customer 
View) 

Customer 

No Query if 
used in 
customer tab 

Status This view is an excellent setting to 
use in the task tab of the customer.    
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Creating Queries 

A Query or filter is used to limit the tasks or records that are shown on the list.   For example, a 
Query would limit the view list to only show open tasks.   A defined or limiting query can reduce 

the amount of time required to load a list of tasks.   

 

Click on the Queries button to set, create, and change the Query setting as shown below.   Click 

on the query icon  if the Query option and button do not show.    

 

Select a query and click on the Close button to change the query.    

Click on the New button to open the Queries Properties dialog window as shown below: 
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Enter a Description of the query. 

A list of some of the most common query options are shown on the Query Properties window.    

Click on one or more of the query options by clicking on the desired options.    

In the example above the user wishes to list all the work orders in the service department.   Since 
all work orders are organized under a single manager, Mike, the Include only this manager’s 
tasks query is enabled.  The Include only tasks that have not been completed query is 
selected to list only the open work orders.    The have or have not options are part of the query.    

The system allows the user to choose an option such as employee, manager, status, etc from the 
view screen instead of setting the employee ID, manger, or other value with the query.    Enable 
the option by clicking on the Choose when viewing option to the right of the option.  For 
example the user can add the Employee and Completion options to the header of the task view 

window as shown below: 
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See the Query Properties settings below: 

 

This query also includes an Advanced query setting.   Click on the Set Query button to view the 

advanced query dialog as shown below: 
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The Advanced query setting can be used independently or in conjunction with the other query 
options.     Review the Features > Advanced Query Options section within the main 
documentation for more details on the advanced query.  

Click OK on properties button to return to the query option list.    

Click on the Properties button to make changes to an existing query. 
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Creating Task Groups 

The task group feature within the task module is a powerful tool to organize tasks and work 

orders in a convenient manner.  Click on the  icon to enable the group option.   Disable this 
option to enhance performance if the query includes a large number of records.   The group 
feature requires the system to load all records into memory before displaying the information.   A 
virtual list is utilized if the group option is disabled.   Records within a virtual list are not loaded 
into RAM memory until the information is displayed. 

The task module groups information within multiple user-defined levels.  This feature gives the 
user many display options within a specific view tab.   For example, the Group option in the task 
list below was selected to schedule an employee.  The Employee & Due Date setting groups the 

task by Employee ID, Past/Today/Future setting, and Date.   

 

Click on the Groups button to change or edit a group setting.   
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Select a new group and click the Close button to select a new group. 

Click on the Properties button to view or edit the group settings as shown below: 

 

The group Description describes the grouping. 

The Default Query setting allows the user to associate a query setting to the group.   This option 
is left blank if the Group and Query settings are independent of one another.   Review the 

Creating Queries section for more details on queries.   

The Employee & Due Date example contains three levels: 

• Level 1 – Employee 

• Level 2 - Past/Today/Future 

• Level 3 – Date 

• Level 4 is extra 

Check one or more of the options within the list to identify a field within the first level of the group.   
The selected field - EMP_ID in the example shown above, groups the first level of the task view 
by the employee id.    Review the Features > Advanced Query Options section in the main 
manual for details on identifying a field name.    

Click on the Level 2 tab as shown below: 
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The Level 2 grouping option is using Advanced code to group the second level.    The second 
level is not identified by a single field or two but is created using programming code.  The 
Advanced option is enabled to change the grouping option from a field list to programming code.   
This code is similar to the advanced query code explained in the Features > Advanced Query 
Options section of the main manual.   

Click on the Level 3 tab as shown below: 
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Configure the Level 3 tab of the group by selecting the DUE_BY field.   You may need to scroll to 
find the selected field within the group since the task record consists of a large number of fields.   

The last level (Level 4 in example above) always contains a list with no selections.   A new 
unselected level will appear each time fields are selected within the "last" tab.      
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Task Status Settings 

The Status setting is a common task setting used to group or query tasks and work orders. The 

status of a task is displayed on the lower right corner of the task. 

 

The status value is not changed directly by the user but is set based on the conditions of various 
information within the task.    

The standard tasks status options are as follows: 

Status Condition 

Open Time > Completed is disabled 

Pending Time > Completed is disabled and General > Pending is 

enabled 

Waiting for 
Parts 

Time > Completed is disabled and Materials > Waiting on 
Parts is enabled 

Completed Time > Completed is enabled 

Approved Advanced > Approved By is populated and Time > Completed 
is enabled 

Billed Time > Completed is enabled and the attached invoice is 
processed  
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Closed Completed is enabled, Approved By is populated, and ( 
Attached invoice status is paid OR (No invoice is attached and 
the Time > Billable is zero )) 

The system evaluates each condition according to the sort order of the records.   The sort order is 
extremely important because the status is set when the first condition is TRUE.    Additional 
status settings and conditions can be added to the EBMS task system by adding records within 
the TAStatus.DBF file. 

 

   Review the Using Tasks as Work Orders section for a status diagram when using a task as a 
work order.  
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Managing Tasks 
Printing Tasks and Work Orders 

Tasks or work orders can be printed to facilitate the flow of information from the time the task is 
created until it is completed and billed or it can be a tag that is printed and attached to a piece of 
equipment.   

The following dual column work order is one of the work order forms available to give to a 
technician in the shop or other location: 

 

• The materials list printed on the left page of the work order are entered within the sales 
order connected to the task or work order.   The shipped quantity will not show on the 
work order.     

 

• The contact information printed in the center of the form header and the directions are 
derived from the customer record.   The directions section will not show if no directions 
exist within the directions tab of the customer.   
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• The task notes are found on the general tab of the task or work order.     The notes 
section will not exist if the directions are blank on the customer and the task note is blank.    

 

• The parts that are used should be noted by writing the quantity in the shipped column.    
The subtotal should be crossed out if not all the parts are used.    Additional parts should 
be noted on the materials list and totaled at the bottom – Total Material.      The Total 
Material value should be copied to the lower left work order total area in the value box 

with the same label.    

 

• Notes about the work that was performed should be noted in the labor section.   
Additional costs should be totaled in the Total Labor box on the lower right side of the 

form. 

 

The task work order should not be used to generate a complete invoice.    The task notes 
should be imported into the sales order and then the dual column sales invoice should be 
printed.   Review the Billing a Project or Task section for more details on generating an 
invoice.   
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Recording Parts and Materials 

An important step in managing a work order or task is to properly record parts and labor notes 
within a task.   This information can be entered directly into the task window if the repair 
personnel have access to a computer.    Bar code scanners or touch screen project stations can 
also be used to record time and materials.  The technician can record time and parts information 
on a printed repair order and then be entered into the EBMS task system by a secretary.   Review 
the Printing Tasks and Work Orders section for details on hard copy work order options. 

Click on the Materials tab of the task as shown below: 

 

The Materials tab will list the items within the entire invoice with some exceptions. 

The following items will show on the list: 

• All inventory items that are classified as Track Count, No Count, Serialized Items, and 
other track count classifications.   (All classifications except Service) 

• All invoice lines with no inventory item that have an Ordered or Shipped quantity that is 

non-zero. 

The following items will not show: 

• All inventory items that are classified as Service will NOT show. 

• All invoice lines that do not contain an inventory item and do not have a value entered into 
the Ordered or Shipped columns. 
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The line items that have been fully shipped can be hidden by enabling the Show only items that 
are not shipped option as shown below: 

 

The Ordered column should reflect the parts and materials that were ordered for a task or 
project.      The user should populate the Shipped column when the items are pulled from 
inventory or used on the project.   Populating the Shipped column will affect the On-Hand value 

within the inventory system.     

Use the Add Item button to add parts or the Delete Item button to remove parts from the work 

order.     These buttons are disabled in the following situations: 

• The Base Type found in the Advanced tab is not Time and  Materials Service. Review 

the Time and Material tasks vs. Contract Tasks for more details on T&M tasks. 

• The sales order has been processed into an invoice.    

 

Review the Waiting for Parts or Materials section for details on the Waiting For Parts option on 
the Materials tab.   
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Waiting for Parts or Materials 

The Waiting for Parts option is located on the Materials tab of the task as show below: 

 

This option is used to manage tasks that are delayed or pending because of missing parts 
needed to complete the task.    The Waiting for Parts option can be enabled immediately after 
the task is created if the project is pending because of parts or tasks that are delayed because of 
missing parts.     

The status of the task will change to Waiting for Parts when this option is enabled.    Create a 
task view within the main task window to display the pending task.     Complete the following 
steps to create this view: 

1. Go to Tasks > Tasks to open the main task window. 

2. Create a Waiting for Parts tab as shown below: 



Tasks 

60 

 

Review the Creating Multiple Views section for detailed instructions on creating a new view. 

3. Set the Query option to the Pending & Waiting on Parts query option.     Create this 

query if it does not exist  by completing the following steps: 

a. Click on the Queries button to open the query list. 

b. Click on the New button to create a new query. 

c. Enter a query label - Pending & Waiting on Parts within the Description field. 

d. Enable the Advanced Query option and click on the Set Query button.  
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e. Set the Database Field, Operator, and Value settings as shown above.    The 
And/Or setting of the first line must be set to OR to include both status settings.     
The And/Or setting on the second line is not used since the settings on line 3 are 
blank.     Click OK to save advanced query settings. 

The query settings within this dialog will query all tasks that have a Status that is 
exactly equal to Pending or Waiting for Parts.    A query based on a single status 
could be set within the main query option list rather than using the Advanced query 
option.     For a single status query, enable the Include only tasks with this status 
option and set the status setting to Waiting for Parts.   

Review the Creating Queries section for more details about queries.  

4. Disable the group option within the list since the number of tasks in this query will be 
minimal.   Review the Creating Task Groups section for more details on the group options. 

This view is useful to manage tasks that are pending.   

Continue with the following steps to review the tasks as parts are received.    These steps are 
normally managed by the receiving department.   

5. Open the purchase order screen when parts are received.    Review the Expenses > 
Purchase Orders > View and Edit Purchase Orders section within the main EBMS manual 
for more details on purchase orders.   
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6. Right click on each individual items as shown below: 

 

7. The Unfulfilled Sales Orders option will only show if unfulfilled sales orders exist.   The 
following list will open if the Unfulfilled Sales Orders is selected: 

 

8.  Select the sales order and click the Source button to open the sales order. 
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9. Open all the tasks by selecting View > Tasks from the purchase order menu. 

 

10. Open the task from the task list by highlighting the task and clicking the View Task button.     
Change the task status from Waiting for Parts to Open by disabling the Waiting for 
Parts option within the Materials tab.   This step will cause the task to show on the 

technician’s task list again.   

The Sales Order Containing Items received report can also be used to print a list of sales 
orders that contain items that are listed on the purchase order.     Attach the following report to 
the purchase order print menu for easy access. 
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Review the Expenses > Purchase Orders > Receive Items against a Purchase Order section of 
the main manual for more details about purchase orders and unfulfilled sales orders. 
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Recording Labor and Completing the Task 

An important step in managing a work order or task is to properly record labor and notes within a 
task.   This information can be entered directly into the task window if the repair personnel have 
access to a computer.  A secretary can enter time after the job is completed if the technician 
records his time on a printed work order.   Review the Printing Tasks and Work Orders section for 
details on hard copy work order options. 

Entering Time 

The amount of time and a description of the project should be recorded within the Time tab of the 

task as shown below: 

 

The Date will default to today’s date.   This date should reflect the date the work was performed.   

Enter the amount of Time spent on the job.    The Time can be derived from the task timer.  This 

timer is located at the bottom of the task dialog as show below: 

 

The stop button  will copy the Elapsed Time to the Time entry within Time tab.  The 

pause button  will cause the timer to pause until the play button  is clicked.   
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Use the directional arrows  to add or reduce minutes within the timer.   The task 
timer starts when a task is opened with the exception of tasks with a base type of Phone.    

Review the Creating Task Types and Defaults section for more details on the phone type.   

The Actual Time value is derived from the total of the Time column.     

The Actual Time value within the time tab of a task may affect the Billable Time which may 
adjust values on the billing invoice.   Review the Time and Material tasks vs. Contract Tasks 
section for more details on how the Billable Time is affected by the Actual Time.   

Completing a task 

A task is marked completed by enabling the Completed option within the Time tab as shown 

below: 

 

The completed option affects the status of the task.     Review the Task Status Settings section 
for more details on task status options. 

The completed switch is frequently enabled by the technician or the secretary that is entering the 
technicians’ time.    A separate approval step is recommended if a manager reviews the total time 
spent on a task before the billing occurs.   Review the Approving Tasks section for more details. 
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Approving Tasks 

The approval process within the EBMS task module is an optional step that is used by a 
manager.    This process is useful in the following situations: 

• The manager reviews and approves each task or work order before the task is invoiced.     

• A manager is required to review all tasks when tasks are completed. 

• The approval step is required to verify that the billable time is properly set for employee 
bonus or commission payments. 

• A manager wishes to review all work orders that are completed for a larger project or are 
specific to individual employees. 

The approval process consists of two features; the manager settings and the approval process.   
Review both sections to properly implement the approval process. 

Manager Settings  

The EBMS task module allows the user to setup managers to review and approve groups of 
tasks.    The manager settings can be used to group tasks even if the approval process is not 
implemented. 

Select Tasks > Options from the main EBMS menu and select the Managers tab as shown 

below: 

 

Click on the Add button to create a new manager.   The Active option must be enabled to use 

the manager within a new task. 

Complete the following steps to set the proper manager within each task type:    

1. Click on the Task Types tab 



Tasks 

68 

2. Select a type 

3. Click on the Edit Defaults button 

4. Click on the Advanced tab 

5. Set the appropriate Manager for the task type 

Repeat steps 2 through 5 for each task type. 

Tasks can be grouped based on manager for scheduling, approval, or general management 
purposes. 

Approving Tasks 

The first stop in implementing the approval step within the EBMS task system is to enable the 
Force Task Approval option.   Select the Tasks > Options from the main EBMS menu and click 
on the General tab.  

 

Create a task list view within the main task widow (Tasks > Tasks) labeled To be Approved as 

shown below: 
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Review the Creating Queries section for more details on creating an additional view. 

Set the Query option to the To be Approved setting as shown above.    

Complete the following steps to create the To be Approved Query if it does not exist. 

1. Click on the Queries button. 

2. Click on the New button 

3. Enable the Include only this manager’s tasks and enable the Choose when 
viewing option. 

4. Enable the Include only tasks that … option and select the have been completed 

option. 

5. Enable the Include only tasks that I [have not] been approved by [any user] option 

and set the appropriate settings to match the options below. 

6. Enable the Advanced Query option and click on the Set Query button.    Set the Set 
Query option as shown below.     
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The combination of these settings will show all complete tasks that are completed and have the 
proper manager settings.  Tasks that have been closed or have already been approved will be 
excluded. 

The manager will individually open each task, review the details, and enable the Approved 

option as shown below: 
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A task can not be approved if the task contains billable Time and no invoice is attached.   
Review the Billing a Project or Task section for more details on attaching an invoice and billing a 
project.    

The user that enabled the Approved option is recorded in the Approved By entry.     

Pre-approving tasks  

There may be a group of tasks that do not need approval.    Complete the following steps to 
bypass the approval process. 

1. Select the Tasks > Options from the main EBMS menu. 

2. Open the Task Types tab. 

3. Select the task type that does not require approval. 

4. Click on the Edit Defaults button 

5. Click on the Advanced tab and enable the Approved option. 

This step will enable the Approved option when a task is created.    This will cause the task 

status to ignore the approved status when a task is completed. 
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Billing a Project or Task 

Many tasks such as sales tasks, internal projects, or support calls are not invoiced or billed.  
Normally, customers will only be invoiced for the tasks that contain billable time.    Complete the 
following steps to invoice a customer for a task:  

1. Click on the General tab of the task to identify the Invoice or sales order setting. 

 

2. If the task has not been associated to a sales order or invoice the Invoice entry will 
be blank.   Proceed to step 7 if the task is already attached to an invoice or sales 
order.       

3. Click on the Select button on the general tab of a task to link an invoice to the task 

as shown above.   The Link to Invoice dialog will open as shown below:     



Managing Tasks 

73 

 

4. Select the first option to create a new sales order or invoice.     Select the I want to 
link this task to an existing invoice option to append the item to an existing sales 

order.     

The second option allows the user to attach tasks to sales orders or processed 
invoices by changing the Status query.   The recommended Status query is the 
Sales Order option since additional time can only be appended to sales orders.   
Click on an existing sales order and click the View Invoice button to open an existing 

invoice or order.    

5. Click on the OK button and the following dialog will open if a Service inventory item 

is attached: 

 

6. Click on the Yes button to create a new line on the sales order, Existing Line to 
add the time to an existing line with the same Service inventory item, or No to 

manually enter the service code line. 

The invoice will open after the wizard is completed if the View the invoice after 
linking option found on the invoice list page was enabled.   

The quantity of the service time that is inserted within the invoice is calculated using 
the Estimated Hours contained within the service items general tab.     The billing 
items must be manually inserted into the invoice or sales order if the Service Item 
found within the Advanced tab of the task is blank.  Review the Attaching a Task to 

a Service Item section for more details about the service item. 
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Tasks can also be attached directly from a sales order or when a proposal is used 
to create a sales order.  Review the Creating a Task from a Proposal or Quote or 
Creating a Task from an Invoice sections respectively for more details. 

7. Right click on the sales order or invoice number and select View Invoice to open 
the attached order.     Click on the Disassociate button to remove the sales order 
from the task.    Disassociating an invoice from the task will NOT delete or remove 
the sales order. 

 

8. The invoice containing tasks is processed in a similar manner as any standard 
invoice.     Review the Sales > Invoices > Processing a Sales Invoice section of 
the main manual for more details on processing an invoice. 

9. The following dialog may appear if the Billable Time within the labor tab of the 
task does not match the billable time within the sales invoice.  The billable time 
within the sales invoice is calculated by multiplying the quantity Shipped from the 
service time with the Estimated Hours found on the general tab of the service 
item.    

 

Click on the Yes button to continue or click on the No button to change the billable time 
within the task.  This billable hour’s comparison dialog will only appear if the Check 
Billable Time Totals Before Processing Invoices option is enabled.   This option is 
found in Tasks > Options – General tab.   
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 Review the Billable Time section for more information on reporting and analyzing the billable 
hours of the company or individual service personnel.   

Tasks with billable time can be applied to a job instead of being invoiced.    Review the Using 
Tasks and Job Costing section for more details on tasks within a job. 
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Billable Time 

Billable time is the amount of time that has been invoiced or billed to a customer.     Labor such 
as sales, warranty, unbilled support, service department cleanup, driving time that is not 
reimbursed, and other overhead labor, is not invoiced or billed.  This unbilled labor must be kept 
to a minimum to make a service  

Managing a service company or division requires affective tools to measure the efficiency of labor 
and employees.    Comparing billable time to the actual time is a powerful way to evaluate the 
profitability of individual employees or an entire service department.   The task module of EBMS 
can help answer some of the following questions: 

• What percentage of an employee’s time is being billed? 

• Is a sufficient amount of time allocated to a task to cover overhead labor costs such as 
scheduling, driving (for on site projects), management, and other labor that is not 
billed.    

• Is the employee completing enough of tasks to be profitable? 

The following types of businesses find that labor management is very important element in 
managing the profitability of the company.   

• General services that are labor intensive 

• Repairs and maintenance 

• Professional services 

• Time & Material (T&M) services 

• Smaller custom manufacturing tasks (The job Costing option of EBMS is a tool that 
can be used to manage labor within individual larger projects)     

The following settings are important settings when tracking billable time. 

A. The Billable Time setting within the work code record should be set accordingly.   Select 
Payroll > Work Codes from the main EBMS menu to open the work code dialog as shown 

below:    
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Enable the Billable Time option for all labor that is invoiced.   All service labor including time 
and materials (T&M) or labor done based on a contact should have this option enabled.    
Payroll work codes such as clerical, sales, cleanup, or other overhead work codes should 
have the Billable Time disabled.    

B. The Billable Time found within the Time tab of the task is an important entry to properly 

evaluate billable time.       
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The Actual Time is calculated from the time entered into the Time tab.   Review the 
Time and Material tasks vs. Contract Tasks section for an overview on how billable time 
is recorded. 

A variety of reports are available to evaluate billable time within the EBMS software.   Select File 
> Reports from the main EBMS menu.   Select Tasks > Billable Time from the menu.  
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The Employee Billable Hours report appears as follows: 

 

The following report compares hours for each invoice: 
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There are many additional reports that allow the manager to evaluate billable time.   
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Reviewing Task History 

Tasks can be viewed and edited from a variety of sources besides the main task view window 
(Tasks > Tasks). 

Some additional views are listed below: 

• Tasks by Customer - Click on the Tasks  tab of the customer record as shown below: 

 

This view is useful when evaluating tasks for a specific customer.   Review the Creating Task 
Groups and Creating Queries sections for more details on grouping and querying tasks. 

• A task by Serialized Items – This view is used to see the service history for specific pieces 
of equipment.   The user needs the optional Serialized Items module installed to use this 
option.    Alls tasks will be listed for a serialized item entered on the general tab of the task.   
See Serial Number field below:  
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Click on the Tasks tab of the serialized item to list tasks as shown below: 
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• Tasks by Job – Click on the Tasks tab of a job 

 

Review the Using Tasks and Job Costing for more details on tasks and job costing. 
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All these task views can be configured to group tasks in a convenient manner.   Review the 
Creating Task Groups and Creating Queries sections for more details on grouping and 
querying tasks. 
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Using Tasks and Job Costing 

The task module can be an excellent enhancement to the option EBMS job costing module.     
Tasks can be used to schedule and track labor within a construction or manufacturing job.     
Tasks can also be used to track labor within a job that manages a contract such as an annual 
service contract. 

A task tab will appear for each job that allows the user to view the tasks within a task. 

 

The tab allows the user to group or query the tasks within the tab.   

The Job and Stage information is recorded within a Time tab of the task as shown below: 
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The Job and Stage can be set per employee time line by displaying the Job and Job Stage 
columns as shown above.  Review the Recording Labor and Completing the Task section for 
more details on entering data. 

 

Billable time can be applied to a job rather than billed to a customer.  The Select button on the 
General tab can be used to apply the time to a job.    The This task applies to the progress-
billing of the job option will only appear if a job is entered in the Time tab of the task. 
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Review the Billing a Project or Task section for more details on this invoice wizard.  

Review the Job Costing manual for more details on job costing. 
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